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Microsoft’s Power BI Workspace: 
 
Background:  
This document provides detailed information about using Microsoft Workspace with Power BI Desktop. The 
Department of Administrative Services (DAS) Datamart team will use Microsoft Workspace as a central hub 
for sharing Power BI Desktop - Datamart Repository files. 
 
The DAS Datamart Repository contains frequently used query and report template files that are widely utilized 
by employees across the state. 
 
To ensure better performance, the DAS Tech Support team recommends that users download files to their 
local desktops rather than working directly within the Workspace, due to limited online computing capacity. 
 
If you are having issues with the Workspace, please contact: Datamart.Support@das.oregon.gov. 
 
Workspace URL: https://app.powerbigov.us/home 
 

  
 
  

mailto:Datamart.Support@das.oregon.gov
https://app.powerbigov.us/home
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How to apply for access to the DAS Datamart Workspace: 
 
To request security access to the DAS Datamart - Power BI - Workspace, please contact the Datamart support 
team at Datamart.Support@das.oregon.gov.  
 
The Datamart support admin team will add the user’s email address to the Workspace and assign them an 
appropriate access level. Power BI workspaces support three roles: Member, Contributor, and Viewer.  
 
Here’s what each role allows: 
Role Permissions 

Viewer Read-only access — can view and interact with dashboards and reports within the Workspace. 
Cannot edit content or add users.  

Contributor Can create, edit, delete, copy, download and publish content and reports in the Workspace; 
cannot add or remove users, and cannot change role permissions.  

Member 
Has all Contributor permissions, plus the ability to add users with lower roles (Viewer, 
Contributor), share content, and publish/unpublish Workspace Apps. Cannot remove users from 
the Workspace or assign someone to be an Admin unless permitted 

 
Datamart support will, by default, assign new users to the Contributor role. This grants them several 
capabilities, the primary one being the ability to download files. While the Contributor role also allows editing, 
we ask that users do not alter files directly on the Workspace site. Instead, please download to your network 
drives, make any necessary changes, and use them as appropriate. 
 
How to work with the Repository files on the DAS Datamart Workspace: 
 
After you’ve been granted access to the DAS Datamart Workspace, follow these steps: 

1. Open your internet browser and go to the Power BI home page: https://app.powerbigov.us/home 
2. Click the Workspaces tab in the left navigation, then select DAS Datamart – Power BI from the list. 

o If you don’t see the workspace listed, contact your agency’s tech support—there may be a 
configuration or permission update needed on your end. 
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3. Once inside the workspace, you’ll see the current Repository files available. 
4. To make it easier to find the files you need, adjust the view using the Filters option: 

o Click on the filters drop-down menu. 
o Uncheck or hide types that are unnecessary (e.g. “Semantic model,” “Other”). 
o Next, select the Report option, so only report files are shown. 

 
File View: 
To view a file in full detail, click the file’s name. There will be multiple tabs available on each file. The 
recommended initial info to review is the Narrative tab. This will provide an explanation of the file along with 
additional details on how the file should be used. It is of vital importance to understand how each file 
operates. After reviewing the narrative tab, you can open the Report tab or tabs within the Pages display. 
These tabs will display the extracted data and will reflect the state of the file at the time it was uploaded to the 
Workspace.  
 
Note: Users should not refresh data on the service/website (per DAS tech support request). However, you can 
still interact with the original loaded data within the file. Start by clicking on a report tab that contains a built-
in filter and interact with the file. (see example below). 

 
 
Built-in filters example: 

 
 
Download File: 
Once you’ve chosen the file you want to download: 

1. Click the file name to open it in Report view. 
2. In the report section, go to the top menu bar and select File → Download this file. 
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Prerequisites & Limitations: 

• You must have Contributor permissions in the workspace to see the “Download this file” option.  
• The report must have been created using Power BI Desktop (or uploaded as a .pbix) or published from 

Desktop. Reports created entirely in the Power BI service may not allow download. 
• Some reports might not be downloadable due to settings like incremental refresh, using large semantic 

models, or other restrictions. 
 

 
 

After selecting to download the file, a pop-up window will display, select the ‘A copy of your report and data 
(.pbix)’ option as shown below:  
 

 

 
Once the file download is complete, open in Power BI Desktop.  
 
Example: Microsoft Edge: Download view:  
 

 



Oregon Department of Administrative Services: Datamart Support 
 

P a g e  5 | 11 

 

 
Note: Files are downloaded with all Power BI views present (Model, Table, and Report). 
 
Example downloaded file: Report view: 

 
 
After Download: 
Once the file download is complete, verify the files report Narrative and follow the instructions within. 

1. Open the file in Power BI Desktop. 
2. Click on the Report View tab. Find and read the Narrative visualization tab. This will help describe what 

the file is about and provide various instructions on how to update it. 
3. Review the Data source settings included in the document and update as necessary.  

Users must ensure their security access to the repository file is current. You may need to update your 
Datamart RACF security credentials by editing permissions to obtain full access to the data. 

        
 

4. Move to the Transform data section by clicking the button on the menu ribbon. 
• Complete any detailed instructions from the ‘Narrative’ visualization. 
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5. Review the Applied steps section of each table to find the filtered data and chosen fields. Update as 
instructed or desired. The information could include basic, advanced or SQL filter options.   
 

             
 

6. Once the review and updates are complete, Close and Apply. 
 
 
Alternative Option: Save a Copy of a Report to Another Workspace 

1. Find the report you want to copy in its current workspace and hover over its name. 
o Click the ellipsis (…)  option menu that appears. 
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2. Select “Save a copy”. A dialog window titled Save a copy of this report will open.  
 

 
o In the dialog, you can: 

1. Enter a new name for the report, and 
2. Choose a destination workspace  

1. Only workspaces where you are a member will appear. 
 

3. Optional: Add a sensitivity label as desired. DAS Datamart data is level 2, which means it is public 
information.  
 

4. Click Save. Power BI will create a copy of the report in the selected workspace. The copied report will 
still refer to the same semantic model as the original. 
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Agency: Workspace Creation:  
If you would like to create your own agency Workspace, please contact your agency's tech support 
department. The Datamart team will only provide support for the internal DAS Datamart Workspace. 
 
Why create an agency Workspace? This is useful when you need a controlled, collaborative environment for 
building, managing, and distributing analytics—especially in scenarios where multiple people or teams work 
together on shared content. 

• A collaboration hub for sharing reports to specific users. 
• The ability to schedule automatic file refreshes and keep data up to date. 
• Role-based access control. 

 
If your agency does not have a Workspace, have your agency technicians submit an Ivanti ticket to DAS EIS.  
 
When a new agency Workspace environment is created, an administrator must be designated to manage and 
organize its users. Administrators can add a user to the Workspace via the instructions listed above.  
 
Once the Workspace is ready, you can upload Power BI Desktop files.  

A. Publish a file to Your Workspace. 
1. Use Power BI Desktop to create your query/report file. 
2. Save the file within your local network. 
3. Select Publish from the Home menu within Power BI Desktop. 

A. It will upload the Semantic model and Report separately within the Workspace. 
4. Go to your Power BI Workspace (https://app.powerbigov.us) to view the file. 

A. The file name with a blue chart icon represents the report. 
B. The file name with an orange icon represents the semantic model. 

 
B. Setting up a Workspace file refresh: Data Gateway connection 

 
To enable automatic refresh for a file in your Power BI Workspace, you must first have a Data Gateway 
connection. The gateway allows Power BI to access and refresh your data sources; without it, your 
reports will not update and will remain static. 
 
If your agency does not currently have a Data Gateway, ask your agency technician to submit an Ivanti 
ticket to DAS EIS. Their team will provision a new Data Gateway server for your agency. 

https://app.powerbigov.us/
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Agencies with a Gateway (Through February 2026): DAS, DELC, DEQ, DHS-OHA, DOC, DOR, DSL, EIS, 
HECC, ODE, ODOT, OLCC, OPRD, OSFM, OSP, OYA, & PERS. 
 
Users must work with their agency’s Power Platform or Power BI administrator to add the Datamart as 
a new source connection within the agency’s Data Gateway. 
 
After the connection is created, the report owner who published the report to the Workspace must 
ensure the Power BI Administrator adds them as a user to the ODBC (SFMSP) connection in the 
agency’s Data Gateway. 
 
Within the Semantic models section, the configuration for the Gateway connection is set under the 
Gateway and Cloud connections area. 
 

 
Once this setup is complete, the report owner can expand the Refresh settings and configure the 
refresh schedule. This determines when and how often the report pulls in new data. 
 

C. Schedule a file to Auto Run 
1. Click on the Report file name (blue chart icon) within the Workspace. 
2. Select the Subscribe to Report option. 
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3. Select: Create a Subscription (only first time). 
A. Click New Subscription (after the first time) 

 

    
 

4. Set the Recipients, date range and time for the auto-run schedule. 
 

     
A. Select Frequency: Daily or Weekly 
B. Select Scheduled time refresh. 
C. Click Save. 

 
5. Once the report is created and saved.  

A. If desired, click Send now within the Subscriptions section to provide the data right away. 
B. Edit the subscription by clicking the pencil icon to the right of the subscription name. 
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D. Share a Report 
1. Click on the Report file name (blue chart icon) within the Workspace. 
2. Click Share from the toolbar. 

 

 
 

3. Enter the email addresses of the recipients. 
• Optional: Add a message 

4. Click Send. 
a. A link to the Report within the Workspace, will arrive in the user’s inbox. 
b. The user must have access to the Workspace to view the link.  

 
E. Edit the Report 

1. Click on the Report file name (blue chart icon) within the Workspace. 
2. Click Edit on the toolbar. 

 

 
 

3. Once editing is complete, select the File drop-down and Save. 
a. Online editing features are limited and may be slow. 
b. It is recommended to edit files within the Power BI Desktop application, due to limited features. 

 
F. Export File: 

1. Click on the Report file name (blue chart icon) within the Workspace. 
2. Select the Export drop-down and select Analyze in Excel, PowerPoint or PDF. 

a. If Analyze in Excel is selected:  
• A Pivot Table with the Data Model info will be exported into Excel.  

b. If PowerPoint is selected:  
• Displays each report page within the file as a page in PowerPoint.  
• It creates a one-page snapshot of all the reports. 

c. If PDF is selected:  
• Power BI creates a static snapshot of all the reports at that moment. 
• It doesn’t convert multi-page reports into a multi-page PDF, it only exports the first page.  
• The PDF contains the current data, filters, and slicers.  

Note: Each export option has its limitations. For the best functionality and flexibility, it’s recommended 
to create the query directly in Excel.  
 


